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Introduction

Touch is an XTension for QuarkXPressfi versions 3.1 and higher. Touch provides a bridge
between Aldusfi Fetch and QuarkXPress by allowing the user to import graphics, text files and
QuarkXPress files from a Fetch catalog into a specialized library, similar to the libraries the user
is accustomed to using in XPress. Additionally, graphics and text may be imported into Touch
libraries an entire folder at a time or from a QuarkXPress document. Touch supports all of the
graphic file types and text file types which are supported by QuarkXPress, making placement
of text and graphics in documents easier than ever. 

Minimum System Requirements

Touch is designed for QuarkXPress 3.1. 
Touch is network protected and is fully compatible with floppy, RAM, or hard disks.
This manual assumes that you are familiar with standard Macintosh� procedures such as
basic use of the mouse, clicking, pulling down menus, copying files, and copying disks. If any
of these procedures are new to you, please refer to your Macintosh user s manual.

Installing Touch

The Touch disk that you have purchased contains the file Touch. To install Touch, drag the file
into the same folder that contains the QuarkXPress application. 

The Touch disk that you have purchased also includes the file Preview Editor Lite. To install
Preview Editor Lite, drag the file into the same folder that contains the QuarkXPress applica-
tion. IMPORTANT:If Preview Editor 2.0 is already present in the folder, do not install Preview
Editor Lite. It may cause conflicts.

After installing Touch and Preview Editor Lite, place the original Touch disk in a safe place. 
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Creating or Opening a Touch Library

To create a new Touch Library, select Open Touch Library� from the Utilities menu. 

The Open Touch Library dialog contains Open and New buttons, enabling the user to either
open an existing Touch library or to create a new library through the same dialog. To create a
new Touch Library, click the New button. An empty Touch palette appears, named Untitled.

A new, empty Touch palette

To open an already existing Touch library, use the Open Touch Library dialog to select the
desired library, then click the Open button. Up to 20 Touch libraries may be open at any time �
provided enough memory has been allotted to the QuarkXPress application.

Adding Items to a Touch Library from a Fetch Catalog

Touch uses the clipboard to transfer items from Fetch catalogs to Touch libraries. To transfer
items from a Fetch catalog into an already open Touch library, activate Fetch and open the
Fetch catalog which contains the graphics, text files or QuarkXPress documents which are to
be placed in the Touch catalog. Select the desired items from the Fetch catalog.

Items selected in a Fetch catalog
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Next choose Copy Reference from the Fetch Edit menu. The Copy Reference hierarchical
menu allows the user to select either Include Text or Include Thumbnails. Since Touch provides
the capability to view thumbnail previews, choose Include Thumbnails. 

Now activate QuarkXPress and make sure the Touch library which is active (frontmost) is the
library which is to receive the transferred graphics. From that palette�s Import menu, select
Import from Clipboard.

Touch imports the items from the clipboard one by one, briefly displaying each item�s thumbnail
and data while a progress thermometer lets the user see how Touch is progressing through the
importing process. 

Transferring items from a Fetch catalog into a new or not currently open Touch catalog is even
simpler. Select the desired items from a Fetch catalog and select Include Thumbnails from the
Copy Reference hierarchical menu as described above. Next, activate QuarkXPress and select
the Open Touch Library� from the Utilities menu. Use this dialog to open an existing library or
create a new one. As the library opens, Touch automatically imports the items from the clip-
board.

Adding Items to a Touch Library from a Document

Touch allows the user to add graphic file entries to Touch libraries directly from the imported
graphics in a document. To add to a Touch library in this way, open the document which con-
tains the imported art which is to be imported into the library. Next open the Touch Library which
is to receive the graphics. From the Touch palette�s Import menu, select Import from
Document�
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The Import from Document dialog appears, allowing the user to select which graphics from the
document are transferred to the Touch library. Items listed one after another may be multiply
selected by clicking on one item on the list, then holding down the shift while clicking on anoth-
er. To multiply select items on the Import from Document list one at a time, hold down the com-
mand key while clicking on the desired items. Buttons at the bottom of the dialog help the user
in selecting multiple graphics from the list. The All Off button deselects all of the items on the
list, while the All On button selects every single graphic listed.

The Import from Document dialog allows the user to choose 
which graphics are imported into the Touch catalog

Once the desired graphics are selected from the Import from Document list, click the Import
button. Touch adds the specified graphics to the library, displaying the importing progress dia-
log to show the user each graphic as it is added.

Adding Items to a Touch Library from a Folder

The third way items may be imported into a Touch library is from a folder. To import items into a
library from a folder, open the Touch library which is to receive the new entries, then select
Append from Folder� from the palette�s Import menu. A dialog appears, prompting the user to
select a folder. 

Select the folder whose contents are to be imported into the current Touch library, then set the
Import File Types check boxes found at the bottom of the dialog. Check the check box corre-
sponding to the file type which should be imported. Graphics indicates that all graphic files in
the indicated folder which are graphic types supported by QuarkXPress will be added to the
library. Text tells Touch to import all text files found in the specified folder. Touch will only import
text files which are recognized by QuarkXPress, so make sure the filters are loaded for all text
file types which might be encountered. Checking the XPress check box indicates that Touch
should add QuarkXPress files found in the folder to the Touch library.

4

Touch



Click the Import button. Touch scans the indicated folder and imports the files whose types
were checked at the bottom of the dialog. Touch displays the importing progress dialog to show
each graphic as it is added to the library.

Saving a Touch Library with a New Name

To save the changes made to a Touch library without saving over the previous version of the
library, select the Save As� item from the Touch palette�s File menu. 

To save the Touch library using a new name, enter the name in the Save Touch Library to field.
Then click the Save button to write the newly-named library to disk.

Saving a Touch Library

Once items have been added or removed from a Touch library, the altered library may be saved
to disk. To save the changes made to the library, select the Save item from the File menu found
on the Touch palette. This saves the altered library by overwriting the previous version.

If the user selects Save from the Touch palette�s File menu in an attempt to save a newly-cre-
ated library which has never before been saved, Touch automatically activates the dialog which
is usually accessed through the Save As� command. See the section above for instructions
for using this dialog.

Removing Items from a Touch Library

To remove one or more items from a Touch library, select the item or items to be deleted. Use
the shift key to multiply select items in the library. Then choose Remove from the Touch palet-
te�s Item menu. The selected items vanish from the palette. 
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If library items are accidentally deleted, close the library without saving the changes made to it,
then reopen the library.

Closing a Touch Library Palette

A Touch library palette may be closed two ways. Either select Close from the palette�s File
menu or click the close box in the upper-left corner of the palette. If items have been added to
or deleted from the Touch library while the palette was open, a dialog appears, allowing the
user to choose whether or not the changes should be saved.

If the changes made to the Touch library are not to be saved, click the Dispose button. To store
the changes, click the Save button. Click the Cancel button to close the dialog and return to the
Touch library.

Viewing a Touch Library in Text List or Thumbnail Formats

The Touch library palette displays library items in one of two formats. The default format is a
text list. The text list display of the current Touch library�s items includes each item�s name, its
file type, the volume where the file is stored, and the folder which contains the file. If the volume
containing the file is not currently mounted, no folder name appears. To change from thumbnail
view to text list view, select Text List from the Touch palette�s View menu.
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Thumbnail format displays a Touch library with each item�s thumbnail preview , file name, file
type and volume noted below the preview. To switch from text list view to thumbnail view, select
Thumbnail from the palette�s View menu. 

A Touch library viewed in text list format (above)
and in thumbnail view format

Changing the Display Order of Items in a Touch Library

Items in a Touch library may be sorted according to several criteria. When a library is first
opened, it automatically displays items in the order they were added to the library. The items
may be displayed this way at any time by selecting By Order from the Touch palette�s View
menu. 
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The library items may also be sorted by file name, graphic type, volume, or folder. Any of these
display orders can be selected by choosing the appropriate item from the Touch palette�s View
menu. A shortcut to displaying by any of these criteria is to click on the word Name, Type,
Volume or Folder found at the top of the columns of information in the palette. Clicking on any
of these underlines the word and sorts the library entries by that criteria. This feature is similar
to the functionality of the Macintosh Finder.

This library is sorted by name � the user can see this at a glance 
because the Name heading is underscored

Displaying Certain File Types in a Touch Library

Touch allows the user to view only certain file types. This makes it easy for the user to �make
invisible� the file types which aren�t currently being used. File type display is turned on and off
using the Touch palette�s View menu. If a file type is unchecked, select it to make the check
appear. If it is checked, selecting it from the menu unchecks it. Checking a file type makes all
library entries of that kind visible in the Touch palette, and unchecking the file type makes the
library entries invisible.

The file type entries in the View menu correspond to the three file types handled through
Touch. They are listed as QuarkXPress Files, Graphics Files and Text Files. 

Viewing Information about Library Items

To view more detailed information about one or more entries included in a Touch library, select
the desired item(s) on the Touch palette and then choose Get Info from the palette�s Item
menu.
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The Touch Information dialog displays detailed information about the specified library entries,
one at a time. Information shown includes the file name, file type, size, date of file creation and
the date the file was last modified. Also listed are the volume, the full path name, and the appli-
cation which created the file. Additionally, if a caption or document description are embedded in
the document, that text is displayed at the bottom of the Touch Information dialog.

Beneath the thumbnail preview display are three buttons. One, labeled Done, closes the dia-
log. The other two buttons contain arrows which allow the user to view file information about the
various Touch library entries which the user selected. If only one entry is selected when the Get
Info� command is chosen, the arrow keys are unavailable. 

The Touch Preferences

The Touch preferences determine what happens when items are imported from a Touch library
into a QuarkXPress document. To activate the preferences, dialog, select Preferences� from
the Touch palette�s Item menu.

At the top of the Touch Preferences dialog are two check boxes, labeled Delete Placed Items
and Flag Placed Items. Although neither of these check boxes must be checked, the user can-
not check both boxes at once. If the Delete Placed Items check box is checked, whenever an
item is placed in a document from the Touch palette, that item is automatically deleted from the
Touch library. This feature helps the user eliminate duplicate placement of items. 
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Flag Placed Items Feature: A dagger marks this item as 
already having been placed in a document

Checking the Flag Placed Items check box causes Touch to mark items when they are placed
in a document. A small red dagger appears as a marker so that the user can tell that the item
has already been placed. To clear the markers from the Touch palette, close the library, then
reopen it. Even if library changes are saved, the flags are not.

The Touch Preferences dialog The Graphic Importing popup menu
from the Touch Preferences dialog

A popup menu on the Touch Preferences tells Touch how graphics should be scaled when they
are placed in a QuarkXPress document from a Touch palette. The Graphic Importing popup
menu offers five options:

Scale Graphic (Constrained) � Touch creates a 1"x1" picture box and scales the graphic
to fit the box, keeping the X% and Y% values equal. 

Scale Graphic � Touch creates a 1"x1" picture box and scales the graphic to fit the box.
Since the X% and Y% values are not kept equal, some distortion of the image is
possible.

Resize Box � Touch creates a picture box and imports the graphic into the box at 100%
scale. Then Touch sizes the box to fit the graphic. If scaling the box to fit the graph-
ic would place part of the box off the pasteboard, Touch does not resize the box.

Full Size Graphic � Touch creates a 1"x1" picture box and imports the graphic at 100%
scale.

Ask User � Each time a graphic is placed in an XPress document from a Touch library, a
dialog appears, allowing the user to choose how the graphic should be scaled.

10

Touch



If Ask User is set in the Touch Preferences, The popup menu
this dialog appears each time a graphic is placed from Touch from the dialog shown at left

Importing Graphics from Touch Using the Place Command

Graphics from a Touch library can be added to the current document without the user�s creat-
ing a graphic box to receive them. One way to add a graphic to a document is to select the
desired graphic on the Touch palette, then choose Place from the palette�s Item menu. 

Touch creates a graphic box at the X=1" Y=1" coordinate on the current document and imports
the selected graphic into the box. If the graphic box is created, but it remains empty, make sure
the volume containing the original file is mounted. The Place command may also be used to
quickly import several graphics from a Touch library. Multiple-select the graphics which are to
be added to the document, then choose Place from the Touch palette�s Item menu. Touch cre-
ates the graphic�s  box at X=1" Y=1", then cascades picture boxes from that point down and to
the right to accommodate the other graphics being imported. 

Touch cascades picture boxes when multiple graphics 
are imported using the Place command

The Place command is not intended for adding text to QuarkXPress documents from Touch
libraries. If the first item selected in a library is an XPress file, the Place command is disabled. 
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Dragging Items from a Touch Library onto the QuarkXPress Page

To place a graphic or block of text somewhere on the page besides the default X=1" Y=1" coor-
dinate, click on the desired library entry in the Touch palette and drag the cursor over onto the
document. The cursor changes to indicate that a new box will be created ( ). The place on the
XPress document where the mouse button is released becomes the upper left corner of the
graphic box which is created to contain the graphic. Touch creates the new picture box and
imports the graphic into the new box.

This method of item placement may also be used to place multiple items at once. Multiple-
select the library items to be placed in the document, then click on one of them, dragging the
cursor over onto the current QuarkXPress document. Release the mouse button at the spot
where the upper-left corner of the first box should be placed. Touch creates the first text or
graphic box, imports the text or graphic from the Touch library, then cascades the following
boxes down and to the right as it imports the items into the XPress document. 

Touch libraries may contain QuarkXPress documents, but the documents are not accessed by
drag-and-drop methods. Instead, hold down option while clicking on the XPress document in
the palette to open the document.

Importing Graphics into the Selected Picture Box

Touch also makes it possible to select a text or picture box in the current QuarkXPress docu-
ment and then import text or a graphic from a Touch library into the selected box. To do this,
select the box to receive the information, then select the item in the Touch library to be import-
ed and drag it onto the document. The cursor changes to indicate that the item being dragged
will be imported into an existing box  ( ). When this cursor appears, release the mouse button
and the text or graphic is imported into the selected box. It is not necessary to drag the cursor
all the way to the destination box on the document.

Since only one item may be imported into any given box, even when a box is selected in the
document, multiple-selecting items in the Touch palette and dragging them onto the XPress
page displays the cursor which shows that new boxes will be created ( ). Attempting to drag a
text file into a graphic box or a picture into a text box yields the same result. A new box is cre-
ated to hold the imported text or graphic.

Printing the Contents of a Touch Library

Touch allows the user to print out the contents of a Touch library to use as reference. To print a
list of the current Touch library�s contents, select Print� from the Touch palette�s File menu. 
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The printed record of a Touch library looks similar to a Touch library in Thumbnail view. Each
library entry�s thumbnail is pictured, along with its file name, file type, and volume.

Activating Fetch

Since Touch is a way to make Fetch catalogs easily accessible from QuarkXPress, Touch offers
a way to activate Fetch from within QuarkXPress to save the user time. To activate Fetch,
choose Open Fetch from the Touch palette�s File menu. 

If Fetch is already open, it is brought to the front. Otherwise, Fetch launches and is ready for
the user to work with.

Troubleshooting

Problem:When I drag a pictures and text files from the Touch palette onto my QuarkXPress
documents, sometimes Touch creates a box on my document but doesn�t put any text
or graphic in it. 

Solution: The volume where the original file is located is not currently mounted. Mount that vol-
ume, then try again.

Problem:I try to import a folder of text files but most of the files do not get imported into my
Touch library.

Solution: The filters required to read those file types may not be loaded in QuarkXPress. Quit
XPress, install the filters in the folder containing the QuarkXPress application, then
launch XPress and try again.

Problem:Iselect many graphics in Fetch, execute the copy reference command, but only a few
of the files are imported into my Touch library. 
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Solution: The graphic files may be file types that QuarkXPress cannot import. Find a filter which
allows you to import those file types or convert the files to the graphic types supported
by XPress.

Problem:Touch imports the file information from Fetch but there are no thumbnail previews.
Solution: Copy the images using the Include Thumbnails command from Fetch.
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Preview Editor Lite

Preview Editor Lite adds information to the document�s resource fork so that XPreview can dis-
play the document�s pages and vital information about the document such as colors, fonts and
imported graphics used in the document. The Preview Editor Lite XTension works in the back-
ground, adding data to documents whenever the files are opened or saved. 

The Preview Editor Lite preferences dialog allows the user to set the attributes of previews
which are automatically added to each document created or saved while Preview Editor is
loaded in QuarkXPress. To activate the Preview Editor preferences dialog, select Preview
Editor� from the Preferences hierarchical menu found under the Edit menu. 

The Preview Editor Lite Preferences dialog

The settings of the controls on the Preview Editor Lite preferences dialog affect each document
which is opened or created with XPress while the XTension is loaded, so make sure the prefer-
ences are set as desired. The controls found on the dialog include:

Resolve Outdated Previews check box � If this box is checked, Preview Editor updates
a document�s preview information if it is outdated whenever the document is closed,
even when the document is not saved. This helps ensure that a document which
was altered on a computer which did not have Preview Editor installed has its PICT
preview kept current.

Create Finder Icon check box � If this box is checked, Preview Editor Lite adds an icon
to the XPress document so that when it is viewed in Finder, the icon displays a
miniature of the document�s first page.

Add XPreview Information check box � Checking this box causes Preview Editor Lite to
add XPreview data to the resource fork of the document which includes the colors
and fonts used in the document as well as the imported pictures in the document. 

Create Thumbnails check box � This check box causes Preview Editor Lite to create a
thumbnail-size preview for each page of the document. XPreview allows the user to
display these thumbnails one at a time in the XPreview dialog.
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Thumbnail Width and Length fields � These fields allow the user to define the size of the
thumbnails created by Preview Editor Lite. The thumbnail size is defined by the
width and height of the thumbnail in units of pixels.

Preview Editor Lite Notes

Preview Editor Lite stores its information using the �pnot� resource. The �pnot� resource
is standard for document preview information proposed by Apple Computer. The �pnot�
data may be edited or created using resource editing applications such as ResEdit. The
�pnot� resource format is available from Apple Computer.

� The Create Thumbnails option set in the Preview Editor Lite Preferences dialog can sig-
nificantly add to the time it takes to save a document. It is recommended the Create
Thumbnails For Each Page check box be left unchecked unless the user plans to use
XPreview on the documents being created or edited. Turning this option off saves both
time and storage space, since the thumbnails add to the size of the XPress document. It
is not necessary to check the Create Thumbnails for Each Page check box to generate
a finder icon.
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